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ABSTRACT 

 

 Nighttime visibility of pavement markings is provided by glass beads embedded 

into the striping surface. The glass beads take light from the vehicle headlamps and 

reflect it back to the driver. This phenomenon is known as retroreflection. Literature 

suggests that the amount of the bead embedded into the striping surface has a profound 

impact on the intensity of the retroreflected light. In order to gain insight into how the 

glass beads provide retroreflection, an experiment was carried out to produce paint stripes 

with glass beads and measure the retroreflection. Samples were created at various 

application rates and embedment depths, in an attempt to verify the optimal embedment 

and observe the effect of application rate on retroreflection. The experiment was 

conducted using large, airport quality beads and small, road quality beads. Image analysis 

was used to calculate the degree to which beads were embedded and in an attempt to 

quantify bead distribution on the stripe surface. The results from the large beads showed 

that retroreflection was maximized when the beads were embedded approximately 

seventy percent by bead volume. The results also showed that as the application rate 

increased, the retroreflection increased, up to a point and then decreased. A model was 

developed to estimate the retroreflectivity given the amount of beads, bead spacing, and 

distribution of bead embedment. Results from the small beads were less conclusive, but 

did demonstrate that the larger beads are better at providing retroreflection. Avenues for 

future work in this area were identified as the experiment was conducted. 
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 Introduction Chapter 1

It has been estimated that sixty percent of all highway fatalities are a result of lane 

departures [1]. Pavement markings are critical in establishing lane awareness and 

decreasing lane departure incidents. A particular concern regarding pavement markings is 

nighttime visibility. In order to provide improved nighttime visibility for vehicle 

operators, glass beads are embedded into the surface of pavement marking materials. The 

glass beads provide retroreflectivity to the pavement markings. Retroreflectivity is the 

optical phenomenon in which light reflects off of a surface back to its source. Pavement 

markings use retroreflection to reflect light from the vehicle headlights backwards to the 

driver, providing increased visibility.  

The overall objective of this study was to gain insight into the specifics of glass 

bead application which affect the retroreflection of the overall striping. The study aimed 

to show the relationship between the percent of the bead volume embedded in the striping 

and the retroreflection of the stripe by using laboratory produced stripes, which 

incorporated drop-on glass beads,. Various studies have suggested that the optimal 

embedment range is between fifty and sixty-five percent. Striping samples were made in 

a laboratory setting with glass beads dropped on the stripe at various application rates and 

embedment depths. Two sizes of beads were used in sample production in order to 

observe the difference between airport and road quality beads.  

The remainder of this document is presented in four chapters. Chapter 2 provides 

a literature review, which forms the basis of this research. It discusses concepts related to 

pavement striping materials, reflection characteristics, and retroreflective glass beads. It 
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also provides a brief overview of work related to retroreflectivity degradation. Chapter 3 

describes the methodology of experimentation including the construction of the paint 

stripe production apparatus, image analysis, and the production of samples for analysis. 

Chapter 4 provides the results of sample production and discusses insights gained from 

the results and analysis. Chapter 5 provides a summary of results, discusses limitations of 

the experiment, and suggests opportunities for future work. 
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 Literature Review Chapter 2

 Pavement Marking Materials 2.1

A variety of materials are used to delineate the travel lanes on roadways including 

paints, thermoplastics, and other special materials. These materials can be classified in 

two ways: durable and non-durable. In general, paint based materials are considered non-

durable; most other materials are considered durable [1]. Water-based paints and 

thermoplastics are the most commonly used delineation materials by transportation 

agencies [2].The accompanying sub-sections provide a brief overview of common 

striping materials. 

 Water-Based Paint 2.1.1

Water-based paints are the most common delineation materials in use today [4]. 

Water-based paints are widely used because of the relative ease of application and lower 

cost compared to other materials. Water-based paints are suitable for both portland 

cement concrete (PCC) and asphalt concrete (AC). Water-based paints often have a short 

drying time, which allows for the re-opening of traffic to the roadway within a few 

minutes after the paint is applied. One big drawback to the use of water-based paint is the 

service life, which is generally accepted to be less than one year [4]. The actual service 

life is dependent of a variety of factors such as the amount of vehicle traffic and climatic 

conditions, but ranges from six months to two years [4]. 

 Thermoplastic 2.1.2

Thermoplastic is the second-most used delineation material. Although more 

expensive and more difficult to install when compared to paints, the extension in service 
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life helps balance the overall cost to a transportation agency [4]. In general, thermoplastic 

markings have a three to five year service life [4].  Thermoplastics can be used on both 

PCC and AC; however, environmental conditions such as temperature and moisture may 

limit the ability of thermoplastic to adhere to the pavement surface. Since thermoplastics 

have a greater thickness than paint, in general, substantial damage may be incurred on 

thermoplastic delineation during snow plow operations [4]. 

 Preformed Tape Markings 2.1.3

Preformed movement markings can be used in a variety of applications ranging 

from continuous striping, temporary line diversions, crosswalks, and special markings 

such as arrows or words. Preformed tapes can be used in a permanent or temporary 

capacity. Temporary tapes are typically pre-coated with an adhesive for easy installation. 

Permanent tape markings may have a stronger adhesive coating or may be heated to 

create a thermal bond with the pavement surface. On freshly installed or rehabilitated AC 

pavements, the tape can be inlaid into the pavement surface. If the AC is still warm, the 

tape can be rolled onto the pavement with a steel drum during the final rolling of the 

pavement surface. The tape markings may also be overlaid onto the pavement surface on 

older, existing pavements. Preformed tape markings may be used temporarily, but can 

also last up to four years given proper installation [4]. 

 Epoxy 2.1.4

Epoxy markings are durable on both PCC and AC pavement surfaces. Epoxy 

markings are typically two-component materials. The exceptional durability is a result of 

the superior bonding to the pavement surfaces which results from the chemical reactions 
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which occur when the two components are mixed. Epoxy markings, however, require a 

substantial amount of time to cure to the pavement surface. Some epoxy markings can 

take up to forty minutes to cure [4]. One of the benefits of using epoxy markings is that 

epoxy markings can be applied to the pavement surface at surface temperatures as low as 

thirty-five degrees Fahrenheit. 

 Optics 2.2

When discussing the visibility of pavement markings, it is important to have a 

basic understanding how light works in the context of pavement markings. Optics is the 

branch of physics which involves the behavior of light and the interaction between light 

and matter. In this document, ‘light’ refers to the wavelengths of the visible spectrum. 

When light interacts with matter, two outcomes are possible: reflection and refraction. 

When the eye sees an object, it takes in light, which has been reflected off of the object. 

The two types of reflection of interest in this thesis are diffuse and specular reflection. 

When light strikes a transparent object, it can be distorted through refraction. The amount 

of refraction experienced by the light is dependent on the material composition. 

  Reflection 2.2.1

Light can reflect off a surface in three different ways: specular reflection, diffuse 

reflection, and retroreflection. Specular reflection occurs when light hits a surface with a 

particular entrance angle and leaves the surface with an equal exit angle. An example of 

this type of reflection would be a laser reflecting off of a mirrored surface. Diffuse 

reflection occurs when the light source hits a surface and is reflected in a variety of 

directions. The micro-texture of the surface causes the light to reflect in a variety of exit 
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angles which often differ from the entrance angle. Retroreflection is the phenomenon of 

the light hitting a surface and being redirected back to its source. For pavement markings, 

retroreflection is desired for nighttime visibility, particularly for roads with no external 

illumination, so that car headlights illuminate the striping and allow for increased 

visibility. Figure 2-1 illustrates the three types of reflection. Glass beads, which are 

described in Section 2.3, are used to provide nighttime visibility by reflecting the light 

from vehicle headlights. 

 

 
Figure 2-1: Three Types of Reflection [5] 
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 Retroreflection 2.2.2

No matter which delineation material is used, a critical aspect of the delineation’s 

nighttime effectiveness comes from retroreflectivity. The Manual on Uniform Traffic 

Control Devices (MUTCD) defines retroreflectivity as, “a property of a surface that 

allows a large portion of the light coming from a point source to be returned directly back 

to a point near its origin” [6]. For lane delineation, retroreflectivity is quantified by the 

coefficient of retroreflected luminance (RL), which is measured in millicandelas per 

meter squared of luminance (mcd/m
2
/lux). The American Society for Testing Materials 

(ASTM) standard number E1710 specifies that the 30-meter geometry be used when 

evaluating the retroreflectivity of pavement delineations [7]. The 30-meter geometry 

measures retroreflectivity of a point that is thirty meters away from of the light source, 

and is schematically diagrammed in Figure 2-2. This geometry was used in a test 

procedure developed by The European Committee for Standardization (CEN) for 

measuring the retroreflection of pavement marking under dry conditions; the test 

procedure was subsequently adopted by ASTM [8]. The study assumed that the distance 

the driver could see at night was 30 meters [1]. 

 

 
Figure 2-2: 30-meter Geometry [9] 

30m 
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In 2010, the FHWA released proposed guidelines for minimum retroreflectivity 

standards for pavement markings. Until the FHWA released its proposed guidelines, 

researchers had used a wide range of retroreflectivity values for the purpose of modeling 

the degradation of retroreflectivity for various markings. As a result, there is significant 

variation between the estimated service lives of pavement markings, because each study 

used a different retroreflectivity value to determine the point at which the marking was no 

longer useful. Table 2.1 shows the proposed minimum retroreflectivity values proposed 

by the Federal Highway Administration. It is noted that according to Bahar et al, 

participants in a visibility study gave high visibility ratings to markings with 

retroreflectivity values greater than one hundred [10]. 

Table 2.1: Proposed Minimum Retroreflectivity Values for Longitudinal Markings [1] 

 Posted Speed (mph) 

≤ 30 35-50 ≥ 55 

Two-lane roads with center line markings only n/a 100 250 

All other roads n/a 50 100 

 Reflective Glass Beads 2.3

Reflective glass beads are critical for providing non-raised, horizontal pavement 

markings with proper retroreflection. Beads are classified by their size and gradation into 

five categories [6]. By convention, Type I and Type II beads are referred to as ‘standard 

beads’ while the other three types are considered to be ‘large beads’ [1]. Within each 

type, the beads range in size. The specific gradation of bead sizes allows the marking to 

achieve a higher bead density and the proper depth of embedment. The typical bead size 

gradations for each bead type are presented in Table 2.2 and demonstrated in Figure 2-3: 

Bead Types I-V Typical Size Gradation. In general, Type I and Type II are considered 
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‘standard beads’ used in roadway applications, while Type III, Type IV, and Type V 

beads are considered ‘large beads’ and are typically used in airport applications. 

 

Table 2.2: Typical Bead Size Gradations - After [3] 

US Sieve 

Size 

Sieve Size 

mm. 

Mass Percent Passing 

Type I Type II Type III Type IV Type V 

No.8 2.380 - - - - 100 

No.10 1.999 - - - 100 95-100 

No.12 1.679 - - 100 95-100 80-95 

No.14 1.410 - - 95-100 80-95 10-40 

No.16 1.191 100 - 80-95 10-40 0-5 

No.18 1.001 - - 10-40 0-5 0-2 

No.20 0.848 95-100 - 0-5 0-2 - 

No.25 0.706 - - 0-2 - - 

No.30 0.594 75-95 100 - - - 

No.40 0.419 - 90-100 - - - 

No.50 0.297 15-35 50-75 - - - 

No.80 0.178 - 0-5 - - - 

No.100 0.150 0-5 - - - - 
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Figure 2-3: Bead Types I-V Typical Size Gradation – After [3]  

For lane delineation markings, retroreflectivity is provided by the embedment of glass 

beads into the surface of the material. When light from the headlights of a vehicle enters 

a bead on the material’s surface, the light is refracted inside the bead, reflects off of the 

marking material on the underside of the bead, and is refracted again through the bead 

before finally exiting the bead on a trajectory that is similar to the trajectory through 

which it entered. This phenomenon is demonstrated in Figure 2-4. 

 Contribution of Specular Reflection to Retroreflection 2.3.1

The glass beads use specular reflection in the process of providing retroreflection. 

Some light which reaches the glass bead is lost due to specular reflection at the first 

interaction with the bead surface. Once light enters the bead, it is bent by refraction, hits 
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the far side of the bead, and is some is reflected back by specular reflection, although 

most is refracted out of the glass bead. This phenomenon is demonstrated in Figure 2-4. 

Although the light can reflect specularly within the bead, two things can happen when 

specular reflection is considered alone: the light will not exit the bead, or the light exits 

the bead at an angle which does not assist the driver [11]. 

 Contribution of Refraction and Diffuse Reflection to Retroreflection 2.3.2

 When light transitions from one medium to another, it is often bent or distorted. 

This phenomenon is known as diffraction. The amount of diffraction is dependent on a 

material property known as the refractive index. Snell’s Law, shown in Equation (2.1) 

relates the angle of refraction to the refractive indices of the two media as: 

0 1sin sinn i n r   (2.1) 

where n0 is the refractive index of the initial medium, n1 is the refractive index of the 

medium in question, i is the incident angle, and r is the angle of refraction. Air has an 

index of refraction slightly greater than one at standard temperature and pressure. Many 

analyses of refractive angles assume air’s refractive index as equal to one. Typically, the 

glass beads used in pavement striping are specified to have a refractive index of at least 

1.5 [12].   



12 

  

 

Figure 2-4: Retroreflection within a Glass Bead [9] 

The efficiency of retroreflectivity is dependent on a number of factors such as bead 

embedment depth, bead size, density on the paint surface, roundness, the optical 

properties of the paint itself, and the refractive index of the glass bead [13]. A study 

conducted by Grosges analyzed the retroreflection of glass beads on paint striping. Figure 

2-5 simulates the paths of light for a bead embedded sixty percent into the paint film. The 

effective contribution of retroreflection comes from the diffusion cone. Although the 

majority of the emitted rays in Figure 2-5 seem to exit the bead at angles which would 

not be conducive to retroreflectivity, Grosges explained that actual retroreflected light 

comes from the diffusion cone. Grosges also remarked that the major portion of light flux 

constituted light continuing forward (increasing x position in Figure 2-5) and was 

essentially induced by specular reflections within the bead. The retroreflected portions of 

the light flux was provided by the non-directional, diffuse reflection at the back of the 

bead and exited through the diffusion cone [13]. 
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The embedment depth plays a crucial role in the efficiency of this retroreflection. 

Grosges conducted an experiment to evaluate the intensity of the retroreflection at 

various embedment depths. He determined that the intensity of retroreflection is 

maximized when the bead is embedded approximately between sixty and sixty-five 

percent [13]. The variation of retroreflection intensity is shown in Figure 2-6.  

 
Figure 2-5: Ray Tracing Representation of Light Refraction in a Glass Bead at Sixty 

Percent Embedment [13] 

 

 
Figure 2-6: Single Bead Retroreflection Intensity vs. Embedment Percentage [13]. 
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 As demonstrated by Grosges, in order to attain the optimum retroreflectivity, 

beads should be embedded approximately sixty-five percent [13]. If beads are exposed 

less than the optimum depth, the longevity of the beads effectiveness can be reduced. If 

beads are over-embedded the retroreflectivity is reduced. An important contributor to the 

bead embedment is the thickness of the marking and the size of the bead. The bead size 

gradation helps ensure that the majority of beads can achieve the desired embedment 

even with fluctuations in the marking thickness. Paints are typically between fifteen and 

twenty-five mils thick, while thermoplastics can have a range of ninety to one hundred 

twenty mils. Smaller beads may be more likely to become over-embedded if the thickness 

of the marking is too large. Alternatively, large beads may be under-embedded if the 

marking thickness is too small. This demonstrates the importance of using the correct 

sized bead for the specific marking material.  

 Glass Bead Application 2.4

Glass bead applied to pavement markings are applied to the markings at the time of 

installation. One vehicle is used to both apply the marking and embed the glass beads as 

the vehicle travels along the pavement. Beads are either dropped onto the marking or are 

sprayed onto the marking. Although paint thickness and bead application rate are 

specified by state marking standards, these parameters are often difficult to control in the 

field, and the overall quality of the stripe is dependent on the experience of the crew 

installing the marking [1]. Technicians evaluate the amount of beads deposited onto a 

stipe with a magnifying glass and adjust the application of the beads until the desired 

bead density is achieved. A striping vehicle applying glass beads is shown in Figure 2-7 

and Figure 2-8. 
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Figure 2-7: Striping Vehicle Applying Glass Beads with Spray Nozzles [14] 

 
Figure 2-8: Application of Striping and Glass Beads Over Existing Marking [14] 

In order to ensure proper bead coverage, excess beads are applied to the stripe and a level 

of overspill is accepted as industry practice. The low cost of the beads makes more 

precise application of beads or recovery of excess beads uneconomical [14]. 

 Retroreflection Degradation Models 2.5

Initial retroreflectivity is only one component in evaluating service life of pavement 

markings. Various studies have examined the degradation of the retroreflectivity of in 
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service pavement striping. The degradation of retroreflection can be influenced by many 

factors including: 

 Material Type 

 Geographic location 

 Climate 

 Traffic volume 

 Percent heavy trucks 

 Pavement material type 

 Quality of application 

The loss of retroreflection is a key determinant of a pavement marking’s service life. 

Numerous models have been developed in order to predict the loss of retroreflection. 

Most of the models predict retroreflectivity as a function of initial retroreflectivity, traffic 

characteristics, and the age of the markings. A study conducted by the Alabama 

Department of Transportation (ALDOT) conducted a study to examine various 

degradation models in order to determine which model, if any would represent the data 

observed in Alabama. The study found that two models could be used, but that 

extrapolation beyond the available data resulted in service lives over twice that of typical 

thermoplastic markings and occasionally greater that typical pavement service life as 

high as 20 years [15]. The study noted that Alabama had geographical and climatic 

conditions which differed from the conditions present where the models were developed.  

 Thamizharasan et al [15], [16] found that new markings can experience an 

increase in retroreflectivity before experiencing a decrease over time. As new pavement 

markings were exposed to traffic, some of the marking was worn off which exposed the 
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more of the beads. As the beads were exposed and paint worn off, the number of beads at 

sixty percent embedment increased. After this increase, bead loss and the wearing down 

of the markings resulted in a decreasing retroreflectivity. This predictive model is shown 

in Figure 2-9. Much older markings exhibited an almost linear degradation over time. 

The degradation trend of existing striping is shown in Figure 2-10. 

 
Figure 2-9: New Pavement Marking Retroreflection Degradation Trend [1] 

 
Figure 2-10: Existing Pavement Marking Retroreflection Degradation Trend [1] 
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 Methodology Chapter 3

 In order to gain insight into the effects of adding glass beads to pavement 

markings, it was decided that stripes should be made in a laboratory environment. 

Additionally, it was decided that some analysis metrics would be needed in order to 

characterize the arrangement of beads on the paint surface. To that end, image analysis 

was used to interpret the laboratory stripes in an attempt to quantify the bead distribution 

characteristics and see if a correlation existed between these metrics and retroreflection. 

The experimental study presented in this document was divided into three distinct phases:  

1. Design, construct, test, and refine a laboratory apparatus to create paint stripes. 

Then fabricate initial samples to develop stripe evaluation metrics and to properly 

produce the samples.  

2. Create and experiment on paint stripes containing airport quality beads to quantify 

the independent and interactive effects of application rate and embedment depths.  

3. Create and experiment on paint stripes with road quality beads to verify the 

findings from phase 2 and identify any additional interactions between rate, depth, 

and bead type.   

 Phase I: Building Apparatus and Pilot Study 3.1

 Phase I consisted of the construction of the apparatus, testing of pre-production 

striping samples, and defining appropriate evaluation metrics. After the apparatus was 

constructed, airport quality beads were used to fabricate stripe samples, which were 

subsequently examined. Through this examination, the metrics for evaluation were 

developed. 
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 Development of Bead Drop Apparatus 3.1.1

 In order to evaluate the glass beads, it was decided that the beads should be tested 

on a suitable marking material. Although glass beads are often used in thermoplastic and 

paint, it was decided that water-based, latex, traffic paint would be the best media on 

which to evaluate the beads. The paint could be applied at room temperature, which made 

it easier to work with compared to thermoplastic. Thermoplastic would need to be applied 

at a high temperature, which made the use of thermoplastic impractical for this 

experiment. Additionally, since the aim of the experiment was to evaluate the 

retroreflection of glass beads applied to pavement markings, paint was a simple, easy to 

handle marking material which could be used to evaluate the effect of the beads. The 

experiment was not intended to test different colors or materials, so white traffic paint 

was used throughout the three phases. 

 Prior to the construction of the bead drop box apparatus, the critical functions 

were defined.  First, the apparatus would need to provide a suitable base on which to 

carefully apply the paint to a glass substrate.  Second, a mesh box would be needed to 

evenly distribute the gravity-dropped beads. Finally, the dropper mechanism needed to 

hold the beads until the paint stripe below was prepared. The dropping of the beads 

simulates, but does not replicate, the process of the striping truck applying the beads to 

the surface. The apparatus that was constructed was based on the device developed 

during NCHRP Project 4-38 [18]. The apparatus consists of three components: a base on 

which the paint can be applied to a glass plate; a mesh box through which the beads are 

dropped onto the stripe; and a drawdown blade to create paint stripes of uniform 

thickness. 
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Base 

 The base of the apparatus was made of 3/4″ plywood. Along the sides of the base, 

plywood strips were attached and positioned with an appropriately spaced gap so that the 

resulting lip would hold the glass plate in place. The strips also served as a guide for the 

drawdown blade (described in more detail below). The path of the drawdown blade was 

4″ wide. The base of the apparatus is show in Figure 3-1. 

 
Figure 3-1: Base of Apparatus 

Drop Box 

 The drop box component of the apparatus was made from ¾″ plywood and a 

combination of multiple ¼″ square mesh wire. The dimensions of the box are 

approximately 5 ½″ x 19 ½″ x 14″ with ten layers of the ¼″ wire mesh vertically 

separated by 1″. The drop box produces a stripe 4″ wide with beads covering an 18″ 

length of striping. The wire mesh screens are oriented in an alternating 90 degree and 45 

degree orientations to facilitate an even bead distribution. The mesh orientation is shown 

in Figure 3-2. Various views of the drop box are shown in Figure 3-3. 

During the apparatus development and shakedown process, beads were dropped 

through the box onto adhesive tape to make rapid observations on how well or poorly the 

Base

StripsLip
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apparatus could produce an evenly distributed stripe. From the drops on the adhesive 

tape, it was observed qualitatively that when the beads were more evenly distributed at 

the top of the box a better distribution resulted on the adhesive tape. This observation 

lead to the development of a bead dropper that would be attached to the top of the box. 

The goal for this component of the apparatus was to drop the beads vertically through the 

box without any spinning or directional movement. From trials it was found that dropping 

the beads via a spinning dropper could lead to segregation across the stripe width. The 

dropper mechanism is shown in Figure 3-5. The dropper itself was constructed from 

aluminum and designed with springs to hold the dropper closed until the operator 

squeezed the dropper and released the beads. To ensure that an even distribution along 

the dropper length was achieved, straight horizontal lines were scribed on both interior 

sides of the dropper along the entire length. The heights of these lines were established 

based on calculation of the approximate loading rates and assumptions of the packing 

density of spherical beads. 

 
Figure 3-2: Alternating Orientation of Mesh Layer in Drop Box 
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Figure 3-3: Left Drop Box on Base, Right Top View Through Mesh Layers 

Dropper Mechanism 

When the apparatus was being constructed, it was necessary to interpret and alter the 

design developed during NCHRP 4-38. The base portion of the apparatus was 

constructed to provide the same function as the base described from the NCHRP 4-38 

report, but differed in the construction materials. The differences in the base of the 

apparatus are demonstrated in Figure 3-4. 
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Figure 3-4: Differences Between Base of Apparatus (Right) and NCHRP Apparatus 

(Left) 

 

Additionally, the NCHRP Report gave no information on the bead holder/dropper 

apparatus, except that it would swivel to drop the beads through the mesh box. An initial 

attempt to replicate this mechanism was unsuccessful and led to lateral segregation of the 

beads across the stripe width. Thus, it was decided that a custom bead dropper would be 

fabricated so that the beads could be held in place until the operator was ready to drop the 

beads through the box. A dropper was fabricated which opened from the bottom so that 

the beads would fall through the box due to gravity alone. The hopper allowed the 

operator to load beads into the device and spread the beads evenly along the length of the 

dropper. The dropper mechanism is shown in Figure 3-5. 
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Figure 3-5: Fabricated Bead Dropper 

Drawdown Blade 

An important part of the stripe fabrication process was ensuring that a consistent and 

repeatable film thickness could be applied to the glass plate. Part of this process involved 

the plywood strips that held the glass plate firmly in position. However, the major 

component to control the film thickness was a multi-path drawdown blade shown in 

Figure 3-6. This blade was purchased from The Paul N. Gardner Company, Inc. and had 

eight paths with gap openings of 5, 10, 15, 20, 25, 30, 40 and 50 mils. The openings in 

the drawdown blade did not result in an equivalent wet film thickness. As the paint dried, 
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it contracted so that the final dry thickness was less than the wet thickness. Combs with 

numerous mil openings were used to record the wet film thickness of each sample. When 

placed into the paint surface, some tines of the comb would touch the paint, while others 

would not. The actual wet film thickness was between the last tine with paint and the first 

tine without any paint. The wet film thickness comb is shown in Figure 3-7. 

 
Figure 3-6: Eight Path Drawdown Blade Applicator 
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Figure 3-7: Wet Film Thickness Comb 

 Initial Test Stripes 3.1.2

Once the device was finalized initial test stripes were created using the sample 

production procedure outlined in NCHRP Report 743. The general procedure for sample 

preparation was as follows with a more detailed step-by-step procedure given in 

Appendix A: 

 Weigh out the appropriate amount of glass beads 

 Place beads evenly in the hopper at the top of the drop box 

 Place the glass plate into the base of the apparatus 

 Pour the traffic paint into a manageable container 

 Place the drawdown blade on the glass plate so that the desired opening will 

produce the stripe 

 Pour paint into the center of the drawdown blade 
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 Move blade lengthwise from right to left across the glass plate to produce the 

stripe 

 Allow excess paint to fall off the glass base 

 Move drop box into position on top of the base 

 Drop beads through the hopper and drop box within twenty seconds of paint 

application 

Seven sample stripes were created and the retroreflectivity was measured and recorded 

using a Delta LTL-X Retroreflectometer, which is shown in Figure 3-8. 

 
Figure 3-8: Delta LTL-X Retroreflectometer 

The retroreflectometer uses the emission and observation angles specified in the 30-

Meter geometry and has a measurement area of 200 mm by 45 mm. The stripes were 

masked with duct tape so that only a central 200 mm by 45 mm area was exposed to the 
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retroreflectometer. For these initial trials, in addition to measuring the retroreflectivity of 

a central area, the retroreflectivity was measured along the stripe in order to become 

familiar with the apparatus, expected outcomes, and measurement area.  

 Image Analysis 3.1.3

From these initial trials it was apparent that the number of beads on a stripe as 

well as their distribution, embedment, and spacing were all important factors affecting the 

retroreflection. It was also hypothesized that the bead distribution and nearest neighbor 

distance could affect the retroreflectivity through interference in the path of the light back 

to the device. Thus, metrics were needed in order to control the stripe-to-stripe variability 

(sample quality) and to index the spatial distribution and number of beads on a stripe. For 

this process it was necessary to count and obtain the position of the beads on the stripe. 

Given the sometimes large number of beads that can exist in a single stripe and the need 

to assign x, y coordinates to each one, it was determined that image analysis would be the 

most efficient and repeatable method to examine the beads and develop the necessary 

metrics. 

In order to perform the image analysis, images of the striping samples were 

obtained through the use of a digital scanner. This allowed for a direct, overhead view of 

stripe to be obtained. Stripe samples with the airport quality beads were scanned at a 

resolution of 1200 pixels per inch. An example of a scanned central area image is shown 

in Figure 3-9. 
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Figure 3-9: PB06 Central Area Scan 

 Once the scan was obtained, the image was opened in the image analysis software 

ImageJ. The software was then used to convert the image of the beads on the stripe to a 

binary image. Once the image was converted to a binary image, the built in analysis 

software was used to count and assign coordinates to the beads in the image. Counted 

particles were represented by an ellipse. Figure 3-10 shows part of an image where the 

ellipses representing counted particles are overlaid onto the original image. It can be seen 

that the analysis counted the darker area of the beads. This means that the data collected 

about each bead cannot be used for the embedment analysis, but the x, y coordinates can 

be used to record the position of each bead. Once the image has been analyzed, the x, y 

coordinates of each bead were recorded and assembled into a spreadsheet for further 

analysis.  

 
Figure 3-10: PB01 - ImageJ Counted Particle Ellipses Overlay on Original Image 
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 In order to verify if the software was providing a reasonable bead count, the 

theoretical number of beads present in the analysis area was calculated for each 

application rate and bead size. The mass of beads applied to the stripe, the volume of the 

glass beads, and the specific gravity of glass were used to calculate the theoretical 

number of bead present in the measurement area. The specific gravity of glass was 

assumed to be 2.5. The results of this verification are shown in Figure 3-11 and  

 
Figure 3-11: Bead Count Verification – Big Beads 

The agreement between the theoretical and observed bead count is very good for the big 

beads. The measured bead counts are slightly below the line of equality, which implies 

that fewer beads are measured than expected. This is not completely unexpected, because 

the distribution of beads on the entire stripe is not completely uniform, which is an 

assumption of the calculated number of beads present. 
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Figure 3-12: Bead Count Verification – Small Beads 

Although the agreement for the small beads is not quite as good as the agreement for the 

big beads, it is not far from the line of equality. Once again, the calculated case assumed 

that the beads were evenly distributed across the entire stripe, but actual samples would 

not have a precisely uniform distribution of beads. Additionally, since the counting of the 

small beads is more difficult due to their small size and difficulty in distinguishing beads 

from shadows, it is more likely that some artifacts may have been counted and included 

in the overall analysis. 

 After the coordinates of the beads were recorded, the data were imported into 

EXCEL for further analysis. It was decided that three metrics would be used to evaluate 

the beads: number of beads, distance to the nearest neighbor, the Variance to Mean Ratio 

(VTMR), and the nearest neighbor distance in the x-direction. The number of beads 

counted from the image analysis served to confirm the theoretical application rate (from 

0

5000

10000

15000

20000

25000

30000

35000

0 5000 10000 15000 20000 25000 30000 35000

M
e

a
s

u
re

d
 A

v
e

ra
g

e
 N

u
m

b
e

r 
o

f 
B

e
a

d
s

 I
n

 M
e

a
s

u
rm

e
n

t 
A

re
a

Calculated Number of Beads In Measurement Area



32 

  

mass-volume based calculations) and also to ensure that minimal loss of beads occurred 

within the apparatus during fabrication. 

 The Variance to Mean Ratio (VTMR) was used as an indicator of how well or 

how poorly the beads were dispersed on the stripe at a macro-level. The VTRM is used in 

Point – Pattern analysis as part of the Quadrant Count Method [16]. This kind of spatial 

analysis is sometimes used in ecological studies of plant populations. In this method, the 

measurement area is divided into equally sized ‘quadrants’ and the particles within each 

quadrant were counted. Since more than four quadrants can be used, the areas in which 

particles were counted will henceforth be referred to as ‘cells’. The particles in each cell 

were counted. Finally, the VTMR was calculated by dividing the variance between the 

values of the counted particles in each cell by the mean value of particles present in all 

cells using Equations (3.1) through (3.3). 
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 An example of the Quadrant Count Method using the VTMR is demonstrated in 

Figure 3-13, where the number of beads in each cell is shwon. The value of VTMR 

indicates how well dispersed the beads are on the paint stripe. It is interpreted by relating 

its value to the number one. Three possible outcomes exist from calculating the VTMR: 

 VTMR>1: Clustered Pattern 

 VTMR<1: Regularly Dispersed Pattern 

 VTMR=1: Random Pattern 

 

 
Figure 3-13: Demonstration of Quadrant Count Method 

After calculating the VTMR, the nearest neighbor distance was calculated for every bead 

was calculated and the average value was recorded. The nearest neighbor was calculated 

by calculating the distance from each bead to all other beads. The minimum value was 

the distance to the nearest neighbor. In addition to the nearest neighbor distance, an 

additional distance called ‘The X-Direction Nearest Neighbor’ was calculated in order to 

see how close the beads were in the direction of lighting. This metric provides an 

indication of particle spacing, like the VTMR, but at a smaller scale. At the outset of this 

study it was unclear which scale (VTMR or X-Direction Nearest Neighbor) would 

control retroreflectivity and so both were evaluated. 

VTMR=166/100=1.66 Clumping Pattern 
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Bead Volume Embedment Calculations Based on Spherical Geometry 

 The most important factor in achieving the maximum retroreflection is the 

embedment of the glass beads. Early on it was observed that the paint tended to form a 

meniscus on the sides of the glass bead due to the surface tension between the glass and 

the paint (see Figure 3-14 (b) versus the idealized embedment case in Figure 3-14 (a)). In 

this case the definition of embedment is somewhat ambiguous, and for this experiment, 

embedment was described based on the amount of the bead volume that was exposed. 

From this exposed volume, and through some geometric analysis (described below), the 

embedment could be calculated and is reported as the percentage of bead volume 

embedded. Other studies have examined the embedment of a single bead and defined 

embedment based on the percentage of the bead diameter exposed. These differences are 

recognized and have been taken into account in the analysis presented in this thesis.  

To measure the embedment of the beads on the stripe two different methods were 

adopted. For stripes with beads embedded at 50% or more, the overhead scanned image 

was used, whereas stripes from beads with less than 50% embedment a side view based 

camera technique was developed. For beads that were embedded greater than 50%, it is 

clear that their apparent diameter would be smaller than the true bead diameter. Figure 

3-14 demonstrates the difference between the bead diameter and the exposed diameter 

due to the paint film thickness. As the thickness of the paint increases, the exposed 

diameter of the bead decreases. By assuming that the beads are spherical a measurement 

of the exposed diameter of a bead allows the embedment depth to be calculated. Once the 

embedment depth is calculated, the amount of the bead embedded in the paint can be 
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calculated as a percentage of the total bead volume. This process is facilitated by using 

the geometry of a partial sphere as shown in Figure 3-14 (d).  

 
Figure 3-14: (a) Side View of Embedded Bead – Idealized, (b) Side View of embedded 

Bead – Actual, (c) Top View of Embedded Bead, (d) Volume Parameters of a Sphere and 

Partial Sphere 

For samples where beads are embedded greater than fifty percent, the top- view digital 

scan was used to measure the exposed bead diameter. The process began by opening the 

image in ImageJ and setting the appropriate scale. In a separate spreadsheet, thirty 

random x, y coordinate pairs were generated. Next, the image was examined in order to 

locate beads at the randomly generated x, y coordinates. If a bead was not present at any 

set of coordinates, the nearest bead was selected for measurement. To calculate the 

exposed diameter of a bead at the given coordinates, a line was drawn in ImageJ in both 

the x and y orientations. The exposed diameter was then calculated be averaging the 

exposed diameters measured in the x and y directions. Once the measurements were 

completed on all thirty points, the overall average exposed diameter was calculated. 
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 To calculate the percentage of bead embedment, three values were required: 

absolute bead diameter (r), exposed bead diameter (c), and height depth of embedment 

(h).  From the previous step, the exposed radius was calculated by dividing the exposed 

diameter by two.  For this process the actual diameter of the beads should be known. The 

beads in all trials were carefully sieved to provide as near to uniform sized beads as 

possible. In addition, calibration samples were prepared wherein the bead diameters were 

measured using the same image analysis software used to find the exposed diameter of 

the beads. This analysis was conducted separately from the stripe samples and confirmed 

that the beads chosen had a uniform diameter with 84% of the diameters falling within 

7% of the mean value. By measuring c and assuming the average radius r, the height h 

was calculated using Equation (3.4). Equation (3.5) was used to calculate the volume of 

the spherical bead embedded in the paint. Finally, the percentage of the bead volume 

embedded in paint was calculated by comparing the embedded volume to the overall 

volume of the bead. The overall volume of a bead was calculated using Equation (3.6). 

 2c h r h   (3.4) 

2 2' 3
6

V h c h


   (3.5) 

33

4
V r  (3.6) 

 For beads which were embedded less than fifty percent, an alternate calculation 

needed to be conducted. It would be impossible to see the exposed diameter of a bead 

which was embedded less than fifty percent from a top-down view because the beads 
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were not transparent enough to see the exposed diameter. Therefore, in order to calculate 

the percentage of bead embedment, angled photos were taken and analyzed. 

 For side-view imaging the stripe sample was placed at an angle of 14.63° and the 

camera was placed in front of the sample as level as possible. Marks were placed on the 

sample in order to divide the sample in thirds. When taking images of the sample, it was 

not possible to have the whole third of the sample in focus. So the focus length was 

adjusted so that a band of beads would be in focus in the image. Two images of each 

third were obtained so that two bands of in-focus beads could be analyzed. 

 As with the overhead method, thirty points were randomly selected for 

embedment analysis. Since two images were obtained for each third of the sample, six 

images in total would be used to calculate the embedment of the beads on the stripe. Five 

beads from each sample were analyzed. Figure 3-15 demonstrates the in-focus areas in 

each third of a sample. From each image, five beads were examined and the percentage 

of embedment was calculated using the overall bead radius and the exposed height. 

 
Figure 3-15: Bands of In-Focus Beads in Side View Embedment Calculation 

Using Equation (3.4), the observed bead radius and bead height were measured and the 

variable c was calculated for each bead observed. As with the greater then 50% 

embedded cases, the volume of the partial sphere embedded and exposed were calculated. 

Bands of In-Focus Beads
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It should be noted that since the images were taken at an angle and not from a directly 

horizontal side view, the measured height needed to be corrected a more accurate bead 

height could be used to calculate the exposed volume. A drawing a bead at an angle of 

14.63° and a correction value was calculated and applied to the recorded height 

measurements. 

 Novel Contributions to Apparatus and NCHRP Procedure 3.1.4

The apparatus described in Section 3.1.1 was constructed using specifications 

outlined in NCHRP Project 4-38. Although the description of the apparatus was sufficient 

to construct the apparatus, specifics on how to build the apparatus were lacking. Some 

liberties were taken in the construction of the apparatus which included the mesh screen 

orientations and the bead dropper mechanism. Specifically, the bead dropper mechanism 

was constructed so that the beads would drop straight down through the mesh box 

without any rolling movement. Once loaded into the dropper, the bottom of the dropper 

opened up beneath the beads when the operator was prepared to drop the meads through 

the mesh screens. The mesh layers were installed in alternating ninety and forty-five 

degree orientations, which were not specified in the apparatus specifications. 

Construction of the apparatus was simple and was constructed with readily available 

materials. 

The most significant alteration to the procedure outlined in NCHRP Project4-38 

was the addition of image analysis to better estimate the embedment of the glass beads. 

The procedure outlined in the report relied on a visual verification to check if the beads 

were embedded approximately 60%. Although the percent of bead volume embedment 

could be estimated from the wet film thickness measurement, there are other factors 
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which contribute to the overall embedment of the beads. For example, as the application 

rate increases, the amount of paint displaced by the beads also increases. As a result the 

paint creeps further up the sides of the beads increasing the overall bead embedment. The 

meniscus of the paint creeps up the sides of the bead (as shown in Figure 3-14b) resulting 

in deeper embedment. By using image analysis, the average percent embedment of the 

beads can be better estimated by observing the actual exposed diameter of embedded 

beads. By measuring the exposed diameter and using spherical geometry, the meniscus 

effects of the paint can be taken into account. Figure 3-16 shows that using image 

analysis can resulted in a percent embedment value which can differ from the percent 

embedment calculated from the film thickness. It can also be seen that the small beads 

show a greater amount of embedment than the film thickness suggests. This is because 

the large amount of beads results in a greater surface area for meniscus effects to alter the 

embedment when compared to the small beads. Image analysis also provides a more 

objective evaluation of the bead embedment than examining the embedment visually by 

eye. 



40 

  

 
Figure 3-16: Percent Embedment Calculated From Film Thickness and Image Analysis 

 Phase II: Production of Samples with Airport Quality Beads 3.2

 Phase II consisted of incorporating the lessons learned from Phase I and creating 

samples for analysis. A uniform gradation of -16+20 mesh glass beads was used. This 

translates to possible bead diameters ranging from 1.19mm to 0.841mm. A sample of 

beads was placed on the scanner and analyzed in order to measure the average diameter. 

For big beads the average diameter was found to be 1.01mm. Based on the definitions 

given earlier, these are considered to be ‘large beads’ and would be used in airport 

quality glass bead mixes. It was decided to use uniformly sized large beads in order to 

ensure that the procedure used to create the striping samples could be altered in such a 

way as to vary the embedment of the beads at the various application rates. Four 

application rates were used in order to observe the effect of various application rates on 

the retroreflectivity of the stripes. 
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 Sample Preparation  3.2.1

 The goal of Phase II was to use the procedure from Phase I to observe the 

relationship between embedment percentage and retroreflectivity for different bead 

application rates. It was decided early-on that the materials evaluated in this project 

should reasonably reflect in-service materials. From a review of the literature including 

the Arizona Department of Transportation’s specifications [4],[18][19] it was found that a 

nominal rate of 6 lb/gal (6 lb of beads per gallon of paint) was typical. Thus, this rate was 

chosen as the basis for further experiments. These units, while very useful in field 

applications, resulted in some issues for this laboratory study. Recall that the primary 

purpose of this project was to evaluate the individual and combined effects from 

embedment depth and particle spacing. Thus it was necessary to control one or the other 

variables and adjust the other, e.g., maintain the bead density but vary the embedment 

depth. Since it was difficult to directly control the embedment (embedment occurred due 

to gravity) the decision was made to control embedment by reducing the thickness of the 

paint. However, reducing the thickness of the paint effectively increased the dosage rate 

of the beads since less paint was applied to the stripe. Here, the dosage rate (6 lb/gal) is 

used as a surrogate measure for bead density (beads/mm
2
) and is accurate only at a wet 

film thickness of 15 mil. This approach was taken as a means to interpret the data 

efficiently, but also as a way to generalize the findings for application to thermoplastics 

where the stripe thickness may be many times the diameter of the bead and embedment 

depth can be more carefully controlled by adjustments to the thermoplastic temperature. 

The amount of beads applied to each sample was recorded as the mass of beads applied to 

the stripe. The mass of the beads applied was kept constant for each application rate, thus 
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using the around the same number of beads on each sample while changing the paint film 

thickness. For example, it was found that 13g of big glass beads would equal the 6lb/gal 

bead application rate. The 13g was kept constant over multiple samples and classified as 

6lb/gal, even though the true application rate changed as the paint thickness changed. 

In addition to the 6 lb/gal rate, it was decided to make samples which would 

represent a 3 lb/gal, 1.5 lb/gal, and 12 lb/gal rate in order to observe the change in 

retroreflectivity with the number of beads on the stripe. Recall, for this thesis the 

application rate, although presented as a lb/gal rate, was really a bead mass per stripe rate. 

Although the area of retroreflectivity measurement is only 200 mm x 45 mm as stated in 

Section 3.1.2, the size of the whole stripe on which the bead were dropped was 4″ x 18″. 

The mass of beads applied to the stripe for each application rate are presented in Table 

3.1. 

Table 3.1: Application Rate Defined as Bead Mass Per Stripe 

Bead Mass/Stripe (grams) Application Rate (lb/gal) 

3.25 1.5 

6.5 3 

13 6 

26 12 

 

The testing of lower application rates would simulate the loss of beads over time 

while the testing at higher application rates would evaluate the potential impacts from 

over application of the beads. The initial experimental matrix involved creating five 

samples at the 6 lb/gal rate in order to characterize the general behavior of the 

retroreflectivity versus embedment curve. Once the general trend was seen, three samples 

would be produced at the other rates. As it will be discussed in Section 4.3, the original 
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matrix was expanded upon as gaps in the data were observed and as the feasibility 

creating samples at all the embedment values was evaluated. The initial Phase II 

production matrix is show in Table 3.2. 

 

 

Table 3.2: Phase II Production Matrix 

 

 
% Embedment 

40 50 60 70 80 

Big Beads 

6lb/gal      

6lb/gal rep      

3lb/gal      

1.5lb/gal      

12lb/gal      

 

 Phase III: Production of Samples with Road Quality Beads 3.3

 Phase III incorporated the lessons from both Phases I and II in order to produce 

and analyze samples made with road quality beads. A uniform gradation of -40+50 mesh 

glass beads was used. This translates to possible bead diameters ranging from 0.420mm 

to 0.297mm. A sample of beads was placed on the scanner and analyzed in order to 

measure the average diameter. For big beads the average diameter was found to be 

0.415mmThe size of these beads classified them as a component of road quality beads. It 

was decided to use only three application rates; 6lb/gal, 3 lb/gal, and 1.5 lb/gal. This was 

decided after observing how many beads were retained on the paint surface and 

observing that the 12 lb/gal rate would result in a large number of beads that could not be 

embedded. Additionally, since the road quality beads were much smaller than the airport 

quality beads, the thickness of the paint was limited to 5 mils and 10 mils with the 

apparatus from Phases I and II. Paint was then also applied at a 1 mil thickness through 
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the use of a custom made drawdown blade shown in Figure 3-17. The same sample 

production procedure from Phases I and II was used in Phase III.  

 

 
Figure 3-17: Custom 1 Mil Opening Drawdown Blade 
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 Effect of Striping Parameters on Retroreflectivity Chapter 4

 Introduction 4.1

The results of the three phases of experimentation are discussed in this chapter. 

From these results, the percent embedment at which the retroreflection was maximized 

was shown to agree with literature. The overall maximum application rate for large beads 

was estimated. Using the results from the large bead samples, a model was developed to 

predict retroreflectivity given the number of beads, nearest neighbor in the x-direction, 

and the distribution of bead embedments. The following sections show and discuss the 

various results from each phase of experimentation. 

 Preproduction Samples 4.2

One of the primary goals for Phase I of this research study was to build familiarity 

with the fabrication and testing procedures. For this purpose, a few stripes were 

manufactured and tested once the apparatus was fully developed and the analysis metrics 

drafted. Since these stripes were important for establishing the experience needed to meet 

the primary objective of this research, but were not directly used to in the data collection 

that addressed that objective they have been referred to as the pre-production samples. 

After these pre-production samples were made, the retroreflectometer was used to 

measure the retroreflectivity of each. The results of the pre-production samples are 

presented in Table 4.1. 
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Table 4.1: Assembled Data of Preproduction Samples 

Stripe 
Bead 

Count 

Bead 

Mass (g) 
VTMR 

Retrorefl-

ectivity 

Embedment 

(% volume) 

Production 

Order 

L-1 1765 17 4.35 561 62.6 1 

L-2 2226 17 3.79 531 83.6 2 

L-3 2941 23 0.93 532 80.9 3 

L-4 1372 11 1.89 499 84.7 5 

L-5 864 5.2 2.1 451 66.4 6 

L-6 1732 17 0.84 630 58.3 7 

S-1 NR 23 NR 89 NR 4 

 

Preproduction Sample04 represented a quick experimentation with small beads.  The 

analysis metrics had not yet been developed for the small beads, thus the retroreflectivity 

is the only recorded metric for Sample 04.  All other samples were produced with the 

large beads at varying application rates and embedment depths. The samples were 

produced in this way to observe the change in the retroreflectivity readings while learning 

how to operate the retroreflectometer.  A graphical representation of the results from the 

preproduction samples is presented in Figure 4-1. Note that these samples represent both 

changing application rates and changing percent embedment. For example, between 

sample L-1 and L-2 the retroreflectivity decreased as the percent embedment increased 

from sixty to eighty percent. Samples L-1, L-2 and L-6 were made with the same 

application rate. L-6 achieved the highest retroreflection and was closest to the optimal 

embedment of 60 percent. Additionally, the lower VTMR of L-6 may also explain why it 

attained a higher retroreflectivity than L-1. Throughout the preproduction samples, 

different levels were achieved, which gave confidence that the procedure could be used 

for the rest of the experimentation. Overall, as familiarity with the apparatus improved 

(e.g., as more samples were made) the VTMR decreased.  



47 

  

 
Figure 4-1: Retroreflectivity of Preproduction Samples 

 

In addition to obtaining the retroreflectivity in the center of the stripe, the first four 

preproduction samples were used to observe the evolution of retroreflectivity along the 

stripe length. This was accomplished by positioning the center of retroreflectometer at the 

edge of the beaded area of the stripe. Retroreflection readings were then taken along the 

stripe by repositioning the retroreflectometer in one inch increments along the stripe 

length.  Each reading represented a different position along the stripe and captured the 

effect of varying the number of beads exposed to the retroreflectometer as well as the 

variation in retroreflectometer readings. This evolution of retroreflection is shown in 

Figure 4-2. In each case, the retroreflectometer began to capture the drop in 

retroreflection at the ends of the stripe. This occurred because the measurement window 

began to include edge areas where no beads had been applied. The results from this 
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examination of retroreflectivity gave confidence that the measurements in the middle of 

the stripe would be representative of the stripe as a whole.  

 

 
Figure 4-2: Evolution of Retroreflectivity Along Four Preproduction Samples 

 

From Figure 4-2 it can be seen that variability exists throughout the length of the stripe. 

The standard deviations in retroreflectivity for these samples are shown in Table 4.2. It 

can be seen from the standard deviation values that L-1 was the most variable of the four 

samples presented. Since sample L-1 was the first sample produced, it is expected that it 

would have the highest variability. Throughout the four preproduction samples, the 

variability decreased dramatically in the center eight inches of the stripe, which is also 

the area in which the retroreflectometer operates.  
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Table 4.2: Retroreflectivity Standard Deviation of Four Preproduction Samples 

 
L-1 L-2 L-3 S-1 

Std. Dev. (18” length) 85.42 51.31 56.34 21.09 

Std. Dev. (Center 8”) 45.47 7.98 16.22 8.49 

 

 Large Bead Production Samples 4.3

The goal of Phase II was to evaluate the relationship between the percentage of bead 

volume embedment and retroreflection and its interaction with bead application rate. To 

meet this goal, stripe samples were created with varying bead application rates and paint 

thicknesses. In addition, the application rate which would produce the maximum 

retroreflection value was calculated from the results. The various analysis metrics were 

examined in order to see if any additional correlations to retroreflection could be 

observed. 

 As samples were produced and the percent embedment was evaluated, the original 

production matrix was expanded upon as shown in Table 4.3. Due to the limited sized 

openings in the draw down blade, it was not feasible to produce samples at forty percent 

embedment for all application rates. For instance, a 3 lb/gal sample was twenty percent 

embedded at a 5 mil drawdown blade opening, but sixty percent embedded at a 10 mil 

opening. Additionally, when beads were dropped onto the paint, the higher application 

rates deposited more beads and displace more paint than the samples produced at the 

lower application rates. 
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Table 4.3: Big Bead Adjusted Production Matrix 

Production Matrix 

  
% Embedment 

  
20 40 50 60 70 80 

Big 

Beads 

6lb/gal 
 

PB04 PB01 PB03 
 

PB05 

6lb/gal rep 
   

PB02 
 

PB06 

3lb/gal PB13 
  

PB07, 

PB16  
PB08 

1.5lb/gal PB14 
   

PB09 PB10 

12lb/gal 
Pb15,P

B17   
PB18 PB12 PB11 

 

The LTL-X retroreflectometer was used to measure the retroreflectivity of each of 

the samples shown in Table 4.4. The percent embedment was calculated for each sample 

using the procedures outlined in Section 3.1.3. The retroreflection versus embedment 

percentage plot is shown in Figure 4-3. 

Table 4.4: Big Bead Retroreflectivity vs. Percent Embedment Results 

Sample 
Application Rate 

(lb/gal) 

Percent 

Embedment 

(%volume) 

Retroreflectivity 

(mcd/lx/m
2
) 

PB09 1.5 73.91 293 

PB10 1.5 85.85 249 

PB14 1.5 27.06 87 

PB07 3 67.60 601 

PB08 3 81.41 457 

PB13 3 25.26 160 

PB16 3 61.20 420 

PB01 6 36.66 442 

PB02 6 67.98 508 

PB03 6 68.73 609 

PB04 6 34.12 375 

PB05 6 84.04 519 

PB06 6 83.80 549 

PB11 12 83.47 450 

PB12 12 76.18 330 

PB15 12 28.00 178 

PB17 12 29.88 194 

PB18 12 68.78 378 
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Figure 4-3: Retroreflection vs. Percent Embedment Phase II 

 

It can be seen from Figure 4-3 that bead application rate can have a profound 

impact on the stripe retroreflectivity. As the application rate increased from 1.5 lb/gal to 6 

lb/gal, the retroreflection also increased. Additionally, the data shows that doubling the 

application rate from 1.5 lb/gal to 3 lb/gal raises the retroreflectivity substantially. A 

similar doubling of the rate from 3 lb/gal to 6 lb/gal results in an increase of the 

retroreflectivity, but not by the same amount as the 1.5 lb/gal to 3 lb/gal increase. 

Interestingly, the change in rate from 6 lb/gal to 12 lb/gal results in a decrease in 

retroreflection. One theory that may explain why the drop in retroreflection occurs 

between the 6 lb/gal and 12 lb/gal cases is that when too many beads are present on the 

stripe surface light interference between the beads occurs, which bends the light away 

from the usable retroreflection angles. In addition to the blockage of light entering the 
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bead, bead interactions could also interfere with light exiting from nearby beads. The 30-

meter geometry illustrated in Figure 2-2 shows that the difference in the incidence and 

observation angle is only 1.05 degrees. If the beads are too close together in the direction 

of the incidence, then a bead may block the light which would have entered the bead 

close to it as shown in Figure 4-4. 

 
Figure 4-4: Bead Interaction Blocks Usable Light 

The trendlines for each application rate shown in Figure 4-3: Retroreflection vs. Percent 

Embedment Phase II were drawn with second order polynomial equations. The equations, 

R
2
 values, and embedment values which result maxima for each trendline are presented in 

Table 4.5. Note that only three data points exist in the 1.5 lb/gal rate; thus, the R
2
 value of 

this data set equals one because a second order polynomial only requires three points in 

order to be defined. It can be observed from Table 4.5 that the coefficients for the 12 

lb/gal, 6 lb/gal, and 1.5 lb/gal rates are similar except for the y-intercept value. The y- 

intercept value is responsible for shifting the trendline vertically, so it is expected that the 

y-intercept between two trendlines would be different. 

 

 

Proper Retroreflection Unusable Retroreflected Light
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Table 4.5: Phase II Trendline Data 

Application 

Rate 

(lb/gal) 

Trendline Equation 

Embedment Which 

Results in Maximum 

(% Volume) 

R
2 

1.5 Y=-0.14x
2
+18.33x-307.91 66.4 1.00 

3 Y=-0.22x
2
+29.87x-463.18 66.8 0.92 

6 Y=-0.13x
2
+18.38x-77.73 68.9 0.81 

12 Y=-0.13x
2
+18.64x-261.71 70.1 0.76 

 

 In order to determine the optimal application rate, the trendline equations were 

used to develop the relationship between the number of beads on the stripe and the 

retroreflection. The bead count was calculated by taking the average of all the bead 

counts in each application rate.  The result of this comparison is shown in Figure 4-5. 

Each curve in Figure 4-5 represents a different percentage embedment. Each application 

rate is represented a constant average bead count throughout each percent embedment 

series. It can be seen that for the all application rates, that the maximum retroreflection 

value occurred at approximately a 68 percent embedment (66.4% – 70.1%), which is 

slightly higher than that predicted by the single bead studies of Grosges [1]. Additionally, 

it can be seen that a bead count approximately equal to 2,000 would result in the greatest 

retroreflection across all embedment percentages. A bead count of 2,000 translates to a 

bead application rate of approximately 7 lb/gal, which is within the typical range as 

discussed in Section 3.2. 
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Figure 4-5: Average Bead Count versus Retroreflection at Various Percent Embedment 

 

 The various analysis metrics were examined to see if any correlation to the 

retroreflectivity could be observed. Although the amount of retroreflection is primarily 

affected by the percent embedment, special parameters could explain any observed drop 

in retroreflection due to bead interference. The nearest neighbor distance for each sample 

was calculated by calculating the nearest neighbor distance for each bead and taking the 

average of all beads. The nearest neighbor distances vs. retroreflectivity for the big bead 

samples are shown in Figure 4-6. 
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Figure 4-6: Nearest Neighbor Distance vs. Retroreflection Phase II 

 

It can be seen that each application rate is primarily associated with a specific range of 

nearest neighbor distances. It is difficult to observe a trend since the retroreflectivity can 

change dramatically between the samples as the embedment changes, but the neighbor 

distance remains fairly constant. However, where retroreflectivity values are similar, the 

sample with a slightly greater nearest neighbor distance has the higher retroreflection. 

Additionally, the effect of nearest neighbor distance may play a greater role when there is 

more potential for interference. The nearest neighbor distance in the 12 lb/gal case is very 

close to the overall bead diameter of 1.01mm, which suggests that beads are almost to the 

point of touching and that the distance between them approaches the length of one bead 

diameter on average. 
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 Small Bead Production Samples 4.4

Following the same procedures from Phase II, samples were made including road 

quality beads. For the small bead samples, the paint was sourced from a different 

manufacturer, but was still white, latex, traffic paint. The diameter of the small beads was 

0.415 mm on average, about 40% smaller than the big beads. Because of this difference, 

the 5 mil and 10 mil openings on the drawdown produced samples with a much greater 

percent embedment. A custom drawdown blade, shown in Figure 3-17, was constructed 

to obtain an embedment less than 50 percent. As samples were produced, it was noted 

that not all the beads applied at the 6 lb/gal rate were adhering to the stripe. This 

suggested that the 12 lb/gal application rate would not be obtainable with the small beads, 

thus 6lb/gal, 3 lb/gal, and 1.5 lb/gal application rates were used for the samples in Phase 

III. The retroreflection versus embedment data is shown in Table 4.6, and demonstrated 

graphically in Figure 4-7. 
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Table 4.6: Small Bead Retroreflectivity vs. Percent Embedment Results 

Sample 
Application 

Rate (lb/gal) 

Percent 

Embedment 

(%volume) 

Retroreflectivity 

(mcd/lx/m
2
) 

PS03 1.5 67 325 

PS06 1.5 93.53 449 

PS09 1.5 11.54 136 

PS02 3 71.88 346 

PS05 3 87.93 453 

PS08 3 15.89 98 

PS01 6 78.37 212 

PS04 6 83.43 360 

PS07 6 3.93 154 

 

 
Figure 4-7: Retroreflection vs. Percent Embedment Phase III 

It can be seen from Figure 4-7 that the samples with small beads did not show the same 

trend as the big bead. It is thought that the high percent embedment and variability of the 

retroreflectometer measurements combined result in data that do not capture the 

theoretical maximum retroreflection between sixty and seventy percent embedment.  
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 Form the small bead results, a similar trend can be observed in relation to the 

application rate. In this case, the 6 lb/gal application rate showed a decrease in 

retroreflection. Although the 6lb/gal rate is within the normal range of application rates, 

and although the beads used in this phase are road quality beads, the small beads are at 

the upper limit of road quality beads. In a typical bead mix, only a small portion of the 

beads would be as large as these beads. Since the beads are the largest component of a 

normal bead mixture, it makes sense that using the typical application with these beads 

may also result in similar interference observed with the 12lb/gal case with the big beads. 

 Development and Verification of Initial Retroreflectivity Model  4.5

 When examining the results presented in Figure 4-3, it can be seen that when one 

compares the results from this experimentation to the retroreflection versus embedment 

curve shown by Grosges in Figure 2-6, the experimental results demonstrate that 

retroreflection is retained as the samples deviate away from the sixty percent optimum. 

The Grosges figure suggests that the intensity of retroreflection at the optimal embedment 

is much greater than the intensity at other embedment depths. 

 Assuming that the phenomenon Grosges presents exists for one bead, it was 

decided to use the idea of a band of retroreflected intensity to model the retroreflection of 

the bead samples. It was decided that Grosges’ intensity curve could be modeled as a 

Gaussian function as shown in Figure 4-8. This function acts as an intensity kernel which 

is applied to each bead sample. The parameters of the Gaussian equation are the mean 

value, standard deviation, and a multiplier factor. 
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Figure 4-8: Gaussian Interpretation of Grosges Intensity Kernel 

 

Beginning with the 1.5 lb/gal cases, the parameters of the intensity kernel were optimized 

so that the kernel would closely predict the retroreflectivity of the 1.5 lb/gal cases. . The 

1.5 lb/gal case was chosen because the beads are far enough apart that light interference 

is less likely to occur. Instead of using the average percent embedment, the percent 

embedment was calculated for all thirty bead examined in the image analysis. From the 

embedments, a histogram was constructed showing the frequency of beads with particular 

embedments. The histogram was developed for Bin values from ten to one hundred 

percent embedment with an increment of three. From the thirty frequencies, the number 

of beads at each percentage embedment was calculated incorporating the total number of 

beads on the sample. Then number of beads at each embedment depth was then 

multiplied by the intensity value at the same embedment depth. From this, the intensity of 

retroreflected light was calculated for the number of beads at each percent embedment. 
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The addition of all intensities for the various embedments resulted equaled the 

retroreflectivity. The intensity kernel was then optimized using Solver to accurately 

predict the retroreflectivity of the 1.5 lb/gal case. 

 Once the intensity kernel was optimized for the 1.5 lb/gal case, the kernel was 

applied to the 3 lb/gal, and 6 lb/gal cases. For the 12 lb/gal case, the measured 

retroreflectivity was lower than the 6 lb/gal case. However, the model would have 

resulted retroreflectivity values higher than the 6 lb/gal cases. As discussed earlier in this 

section, the proximity of the beads to each other causes light interference and therefore 

decreased the retroreflectivity in the 12lb/gal cases. It was determined that a spacing 

factor should be applied to the model so that the effect of light interference could be 

incorporated. The X-Direction Nearest Neighbor distance was used as the basis for the 

spacing factor. The spacing factor itself was modeled as a sigmoidal function, which 

resulted in a factor of 1 for the majority of 1.5 and 3 lb/gal cases and a value of 

approximately 0.2 for the 12lb/gal cases. The shifting function is shown in Figure 4-9. 

 After incorporating this shifting function, the model was used to predict the 

retroreflectivity of all big bead samples. The measured and predicted values were plotted 

against the line of equality. The result of the model prediction is shown in Figure 4-10. 
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Figure 4-9: Sigmoidal Shifting Factor Function for Phase II Samples 

 

 
Figure 4-10: Predicted vs. Measured Retroreflectivity 

It can be seen from Figure 4-10, that the model would provide a fair prediction for the 

majority of cases. Note that since the model was built from the 1.5lb/gal cases, the points 
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which belong to the 1.5 lb/gal dataset are almost directly on the line of equality. The 

shifting factor was also able to predict the retroreflectivity values for the 12lb/gal case. 

Recall that the 12lb/gal case resulted in a lower retroreflectivity than the 6lb/gal case. The 

model was able to reflect this drop due to the addition of the shifting factor. Although 

two points in the 6 lb/gal case are quite over-predicted by the model, the three of the 

remaining four points straddle the line of equality. 

 After the model was developed for the big beads, the same kernel was applied to 

the small beads. The mean and standard deviation of the intensity kernel were kept the 

same, but the intensity value was optimized for the small beads. It was assumed that the 

small beads would be capture less light because the surface area is smaller than the 

surface area of the big beads. The small beads were then used to test the model. The 

model was set to recreate the small bead samples. The measured and predicted 

retroreflectivity were recorded. The results of testing the model with the small bead 

samples are shown in Figure 4-11. 
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Figure 4-11: Testing Model with Small Bead Samples 

From the result of testing the model with the small beads it can be seen that the slope of 

the best fit line is almost equal to one. The vertical offset from the line of equality 

demonstrates that the model does not capture a factor in the small bead retroreflectivity. 

One reason the model may under predict the retroreflectivity of the small is that the 

meniscus effects would be magnified in the small bead samples when compared to the 

large bead samples. Additionally shifting factor from the big beads may not be applicable 

to the small beads, because the intensity kernel did not represent the small beads as well 

as the big beads. Figure 4-10 showed that in general, the intensity kernel was a fair 

approximation of the big bead samples, but this was not the case for the small beads. 
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 Parametric Evaluation  4.6

Even though the data from the small bead samples could not verify the model, the model 

was used to produce artificially generated retroreflectivity versus embedment curves. The 

outcome of generating the retroreflection curves is shown in Figure 4-12.  

 
Figure 4-12: Artificially Generated Retroreflectivity vs. Embedment Curves 

Figure 4-12 was then compared to the retroreflectivity vs. embedment curves from the 

big bead samples shown in Figure 4-13. 
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Figure 4-13: Embedment vs. Retroreflectivity Phase II Results 

When one compares Figure 4-12 and Figure 4-13, it can be seen that the 6lb/gal rate is 

considerably more arched and has a higher retroreflection in general when compared to 

the original data. A reason for this may be that, in general, the 6lb/gal rates considerably 

more over predicted by applying the intensity kernel when compared to the other rates 

(Figure 4-10). Additionally, the simulated 12lb/gal rate has a greater retroreflection than 

the 3lb/gal rate, while the opposite is shown by the real data. Although the trendlines of 

the simulated data follow a broad curve, the data points themselves more closely 

resemble the Gaussian shape of Grosges’ intensity curve. This is expected since the data 

suggested a broad curve and the model uses a narrower Gaussian intensity Kernel. 

Finally, the trendlines of the generated retroreflectivity curves suggest that across all 

application rates, the maximum retroreflection is achieved when the beads are embedded 

around sixty-five percent, which is consistent with both the literature and with the results 

from Phase II. 
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 The overall model can be described in the following form: 
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Where R is the total retroreflection intensity, XNN is the X Direction Nearest Neighbor 

distance, D is the bead diameter, BeadCount is the number of beads present on the 

sample, Ei is the particular percent embedment i, f(Ei) is the number of beads at 

embedment percentage Ei, and A, B, C, F, G, H are constants obtained from the 

optimization with big beads. 

 Due to limited time and resources, additional refinement to this model was not 

possible. It is suggested that additional striping sample be made and analyzed. The model 

should then be re-optimized to account for the additional data. Additionally, although 

other analysis metrics were considered for the shifting function, a better fit may be 

accomplished by using some combination of spatial factors to define the shifting 

function.  
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 Conclusion and Future Work Chapter 5

From experimentation with large beads, the theoretical optimal percent 

embedment was found to be between sixty-five and seventy percent. This agrees with 

various sources which claimed an optimal retroreflection near sixty percent embedment. 

The results from Phase II and Phase III also suggest that there are an optimal number of 

beads which contribute to retroreflection. As the number of beads on the stripe increases, 

the retroreflection increases up to a point after which the bead density became so great 

that the bead geometry results in light interference. Although the light may still enter the 

bead, the angle at which it is retroreflected is of use to a vehicle operator. Using data 

from Phase II, the maximum application rate of large beads was calculated to be 

approximately 7 lb/gal, which is within the typical range of bead application rates. 

Using data from Phase II, a model was developed to estimate the retroreflectivity 

of a stripe given the X Direction Nearest Neighbor distance, bead size, application rate, 

bead count, and distribution of bead embedment percentages. The data was used to 

artificially generate retroreflection vs. embedment curves which exhibited a similar 

behavior to the large bead samples. Although the 6 lb/gal application rate is particularly 

over estimated, the same general trends can be observed between the big bead data and 

the generated data. Alterations and verification of this model with the small beads is left 

for further work. 

Image analysis allowed the percent embedment of particular beads to be 

calculated. For the various analyses, the average bead diameter was used. Future 

refinements in the image analysis could allow much more data to be collected about the 

striping samples in a more automated fashion. If image analysis could be used to estimate 
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the exposed diameter for every bead, then the percent embedment of each bead could be 

calculated. Refinements and increased automation of the image analysis procedure would 

allow for a quicker analysis of the striping samples. 

In order to create striping samples, the apparatus was constructed using 

specifications outlined in NCHRP Project 4-38. Although the description of the apparatus 

was sufficient for construction, specifics on how to build the apparatus were lacking. 

Although some liberties were taken in the construction of the apparatus, the apparatus 

was used to produce paint stripes with drop-on glass beads. Specifically, the bead dropper 

mechanism was constructed so that the beads would drop straight down through the mesh 

box without any rolling movement. The mesh layers were installed in alternating ninety 

and forty-five degree orientations, which were not specified in the apparatus 

specifications. Finally, instead of evaluating the embedment of the beads visually, image 

analysis was used to quantify the percent embedment of a sample of beads on each stripe 

sample. 

The beads used in this experiment were of uniform sizes. However, typical bead 

mixes have a gradation of bead sizes. The sample production could be used with a normal 

bead mix, but the image analysis, as it is now would not be able to tell which beads are 

physical bigger or smaller than the others. As each bead changes in size, the beads 

exposed diameter would produce a different percentage embedment. Future work into the 

refinement of the image analysis could allow typical bead mixes to be used on the stripes 

rather than uniformly sized beads. 
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APPENDIX A 

SAMPLE PREPARATION PROCEDURE 
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Preparation of Glass Substrate 

1. If re-using a glass substrate from a previous sample, ensure that the glass 

substrate is clean. Most water based paints can be removed with warm water and 

scrubbing with a sponge or paper towel. 

2. Ensure that glass substrate is dry before placement into base of apparatus. 

Set up Beads in Drop Box Apparatus 

3. Ensure that the hopper on top of the drop box is closed and secure. 

4. Turn on the balance 

5. Place a clean container on the balance and set to zero 

6. Place the desired mass of glass beads into the container 

7. Monitor the mass and add or remove the beads from the container until the 

desired mass is reached 

8. Transfer the beads from the container into the hopper by carefully and as evenly 

as possible pouring the beads into the hopper 

9. Use a clean paint stirrer or flathead screwdriver to evenly spread the bead the 

length of the hopper 

10. Use the horizontal lines etched into the inside of the hopper as a guide to ensure 

the beads are as evenly distributed as possible. 

11. Tapping the sides of the hopper can help the beads settle in the hopper evenly 

12. Record the mass of beads used on the sample and the application rate 

Set up Base 

13. Prepare the countertop by covering it with newspaper 
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14. Place the base on the counter so that the paint application will go from right to 

left 

15. Place glass substrate on the base by inserting it under the lips provided by the 

plywood strips on the top of the base 

Prepare Drawdown Blade and Wet Film Thickness Comb 

16. Ensure that the drawdown blade is clean and dry 

17. Place the drawdown blade so that the desired opening is facing downward and on 

the right edge of the glass substrate 

18. Record the drawdown blade gap used for the sample 

Prepare Paint 

19. Carefully shake paint can 

20. Open paint can 

21. Thoroughly stir the paint with a wooden paint stirrer 

22. Once thoroughly stirred, pour the paint into a small container such as a small 

paint tray 

Prepare Rinsing Bowl 

23. Prepare a bowl with clean, warm water. 

24. Place the bowl near your work station 

Sample Production 

25. Pour paint into the center of the drawdown blade 

26. Move the blade across the stripe from left to right 

27. Allow excess paint to fall off the edge of the glass substrate 

28. Place drawdown blade into the rinsing bowl 
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29. Move the base away from the pool of excess paint 

30. Within 20 seconds complete the following: 

.30.1. Move the drop box into position on top of the base so that the bars on the 

side of the drop box align with the ends of the base 

.30.2. Unlock the hopper by loosening the rods in the top 

.30.3. Squeeze the top plates of the hopper so that the bottom opens and the glass 

beads fall through the drop box 

31. Remove the drop box and place on the counter out of the way 

32. Take a measurement with the wet film thickness comb as close to the area of 

striping with beads. Ensure that the comb is penetrating the paint all the way to 

the glass substrate without touching any glass beads 

33. Place the wet film thickness comb into the rinsing bowl 

34. Record the wet film thickness measurement 

35. Allow Sample to Dry Overnight 

Cleaning of Equipment 

36. Take the rinsing bowl to a sink 

37. Thoroughly clean all paint off of the drawdown blade and wet film thickness 

comb. Most of the paint will come off with warm water and soap. 

38. Empty the dirty water from the mixing bowl. 

39. Dry the drawdown blade and wet film thickness comb 

40. Carefully close and seal the paint can  

41. Wash any other utensils and containers 

Once sample is dry 
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42. Gently brush off any beads that have not adhered to the paint 

43. Label the sample with a marker of a piece of duct tape on the bottom of the 

sample near one edge 

Prepare Sample for Image Analysis 

44. On the 24″ edges of the glass substrate place a piece of clear tape on the edge so 

that a mark can be drawn at 12″. 

45. Use a thin marker to mark the 12″ point on both sides of the glass. 

46. From each 12″ mark, place a piece of tape 10 cm away on both sides of the mark 

and mark the 10cm distance. This defines the 20 cm length of the measurement 

area of the retroreflectometer. 

47. Place two pieces of duct tape across the sample at the 10 cm marks so that the 

center 20 cm of the stripe are not covered by the tape. 

48. On the duct tape, measure 3″ from the edge to define the center of the stripe 

49. From the 3″ measure 2.25 cm on either side and place a mark on the duct tape. 

This defines the 4.5 cm width of the measurement area 

50. Repeat this for the other piece of duct tape 

51. Place two pieces of duct tape along the 2.25 cm marks so that the central 4.5cm x 

20cm area of the stripe is exposed 

52. On the pieces of duct tape extend the 12″ centerline by connecting the 12″ marks 

drawn earlier. DO NOT DRAW THE LINE OVER THE SAMPLE 

53. On a piece of the duct tape, draw an arrow indicating the direction of paint 

application. 

54. Label the sample on a piece of duct tape 
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APPENDIX B 

IMAGE ANALYSIS PROCEDURES 
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Obtaining Overhead Images 

1. For overhead images use a flatbed scanner capable of obtaining 2400ppi 

resolution. 

2. Turn on the scanner and place the sample so that the side of the stripe with beads 

will be scanned. 

3. For samples with big beads, use a scan resolution of 1200 ppi. For samples with 

small beads use a scan resolution of 2400 ppi. 

4. Run a preview scan. 

5. Depending on the scanner software, crop the preview scan so that the entire 

exposed central area will be scanned along with some of the duct tape. 

6. Scan the image 

7. Save the image 

8. Examine the image to ensure it is not blurry and no errors were encountered 

during the scan 

Obtaining Side View Images 

9. For side view images use the base of the drop box apparatus to prop up one edge 

of the sample. The height of the base was 38.5 mm. 

10. Mark the duct tape near the exposed bead area in order to divide the area into 

thirds 

11. Place the sample so that one edge rests on the edge of the base and the other rests 

on the counter surface. The height of the counter was 36 and 7/16 ″ high. 

12. Place the base of the apparatus so that it is 16cm from the edge of the counter 
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13. Set up the camera on a tripod so that the viewfinder captures the center of the 

measurement area. In this case the bottom of the camera clip was 89.5 cm from 

the floor. 

14. Move the sample so that the first third is captured in the viewfinder. 

15. Adjust the focus so that the nearest bead appear to be in focus 

16. Take the picture 

17. Readjust the focus so that a band of beads further away on the sample comes into 

focus 

18. Take the picture 

19. Move the sample so that the next third of the measurement area is within the 

viewfinder. 

20. Repeat the process of adjusting the focus and taking picture until images of all 

three thirds of the measurement area have been obtained. 

21. Save pictures to a computer 

22. Examine the pictures to ensure that two bands of beads are in focus. 

23. Take additional/replacement pictures as necessary 
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Image Analysis – Overhead Counting Beads 

1. Open the image in ImageJ by clicking File > Open and selecting the desired file 

2. Change the image to RBG color by clicking Image > Type > RBG Color 

3. Change the image to a 16 bit image by clicking Image > Type > 16-bit 

4. Set the image scale by clicking Analyze > Set Scale 

5. In the dialog box ensure that the ‘Distance in pixels’ field match the resolution at 

which the image was scanned 

6. In the ‘Known distance’ field enter 25.4 

7. In the ‘Unit of Length’ field enter ‘mm’ 

8. Click OK to close the dialog box 

9. Adjust image threshold by clicking Image > Adjust > Threshold 

10. Adjust the slider until it appears that all the beads are being captured in the 

binary image. Try a range from approximately 80-200 

11. Close the threshold dialog box 

12. Using the rectangular or polygon selection tool, draw a box around the area of 

the image with beads 

13. Clear the rest of the image by clicking Edit > Clear Outside 

14. Despeckle the image by clicking Process > Nosie > Despeckle 

15. Repeat the Despeckle two more times 

16. Convert the image to a binary image by clicking Process > Binary > Make 

Binary 

17. Click Process > Binary > Open 

18. Click Process > Binary > Fill Holes 
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19. Click Process > Binary > Watershed 

20. Click Analyze > Analyze Particles 

21. In the dialog box: 

.21.1. Size: about 1/10 of the expected area to twice the expected diameter 

.21.2. Circularity 0-1 

.21.3. Show: Ellipses 

.21.4. Check boxes: display results, Summarize, exclude on edges, include holes 

22. Click OK 

23. Three new windows will open: ‘Summary’ displays a summary of the counted 

particles, ‘Results’ shows specific measurements, ‘Drawing of…’ displays an 

image of the ellipses of the counted particles 

24. On the primary ImageJ command window open the original image 

25. Click the ‘Drawing of…’ window to make it active 

26. Click Image > Overlay > Add Image 

27. Select the original image from the drop down list, leave the X location and Y 

location equal to zero and set the opacity to 75% 

28. The overlay image will allow you to see how well or poorly the thresholding 

worked 

29. The overlay can be removed by clicking Image > Overlay > Remove Overlay 

30. Adjust the parameters such as size and circularity in the ‘Analyze Particles’ 

dialog box until satisfied with the particle counting  

31. If necessary, repeat the entire process from the beginning and adjust the threshold 

values in order to count as many particles as possible 
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32. Save the ‘Drawing of…’ image as a Tiff and save the results file as a text file 

 

Image Analysis – Overhead Exposed Diameter Measurement 

1. Open the image in ImageJ by clicking File > Open and selecting the desired file 

2. Set the image scale by clicking Analyze > Set Scale 

3. In the dialog box ensure that the ‘Distance in pixels’ field match the resolution at 

which the image was scanned 

4. In the ‘Known distance’ field enter 25.4 

5. In the ‘Unit of Length’ field enter ‘mm’ 

6. Click OK to close the dialog box 

7. Using the cursor, determine the minimum and maximum x, y coordinates 

8. In EXCEL record the minimum and maximum x, y coordinates 

9. Use EXCEL function Randbetween to generate thirty random x, y coordinate 

pairs between the minimum x and y values 

10. Copy the randomly generated coordinates and paste in the same position as 

‘values’ 

11. Find the first x, y coordinate pair in the image by moving the cursor and looking 

at the displayed x and y position in the main window of ImageJ. 

12. Determine if a bead is present at the coordinates 

13. If no bead is present, find the nearest bead by clicking and dragging the cursor to 

the center of the nearest bead. The length of the line is displayed in the main 

window of ImageJ 

14. When a bead has been located, zoom into the image to 300% 
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15. Measure the x-diameter by clicking and dragging horizontally across the bead 

while holding the ‘Shift’ key. The distance will be displayed in the main window 

of ImageJ. 

16. Record the x-diameter in EXCEL 

17. Measure the y-diameter by clicking and dragging vertically across the bead while 

holding the ‘Shift’ key. The distance will be displayed in the main window of 

ImageJ. 

18. Record the y-diamter in EXCEL 

19. Repeat steps 12-17 for the remaining randomly generated coordinates 

20. In EXCEL, take average the x-diameter and y-diameter for each coordinate pair 

to obtain the average exposed diameter 

21. Record the average diameter of each bead 

 

Image Analysis – Side Angle View Meausrements 

1. In ImageJ, open the desired image 

2. Use the line tool to measure the bead diameter 

3. Record the value in EXCEL 

4. Use the line tool to measure the distance from the paint to the top of the bead 

5. Record the value in EXCEL 

6. Repeat Steps 1-6 for all six images for a single striping sample 
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APPENDIX C 

EQUATIONS 
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Big Bead Partial Spherical Volume 

 

Small Bead Partial Spherical Volume 

 

 

 

 

 

V= 0.54 mm^3

D= 1.01 mm

r= 0.51 mm

Volume of Partial Sphere 40

h= 0.438 mm

r= 0.506 mm

c= 0.501 mm

V= 0.217 mm^3

Target Volume

0.217 0.000 mm^3

Volume of Partial Sphere 60.000

h= 0.573 mm

r= 0.506 mm

c= 0.501 mm

V= 0.325 mm^3

Target Volume

0.325 0.000 mm^3

Difference

Volume of a Sphere

Difference

V= 0.046 mm^3

D= 0.445 mm

r= 0.223 mm

h= 0.429 mm

r= 0.223 mm

c= 0.084 mm

V= 0.046 mm^3

Target Volume

0.046 0.000 mm^3

h= 0.016 mm

r= 0.223 mm

c= 0.084 mm

V= 0.000 mm^3

Target Volume

0.000 0.000 mm^3

Difference

Volume of a Sphere

Volume of Partial Sphere (50% Exposed)

Difference

Volume of Partial Sphere (50% Embedded)
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Big Bead % Embedment Calculation>50% 

 
2 3

4 5 6

92826.555* 850839.972* 4064402.661*

10681066.052* 14656633.180* 8218785.635*D 4021.

%Embed n

65

m

2

e t Diameter D D

D D

  

   
   

Where D is the average exposed diameter of the bead 

Small Bead % Embedment Calculation>50% 

2 3

4 5 6

% 41548.450* 439901.427* 2388156.071*

7057856.682* 10815247.382* 6742593.976*D 1456.938

Embedment D D D

D D

  

   
  

Where D is the average exposed diameter of the bead 

 

MatLab Algorithm for Nearest Neighbor Distance 

[IDX, D]=knnsearch (C,C,’K’,2,’Distance’,’Euclidean’) 

Where C is a matrix with x,y corrdinates 

Matrix IDX equals the index of the nearest neighbor 

Matrix D equals the nearest neighbor distance 

 

Matlab Function for X Direction Nearest Neighbor 
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APPENDIX D 

DATA SHEETS 
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Sample 
Bead 

size 

Applicat

ion Rate 

(lb/gal) 

Bead 

Mass(g) 

Central 

area 

bead 

count 

Retroref

lectivity 

%Embe

dment 
VTMR 

NN 

dist 
XNN 

PB14 -16+22 1.5 3.25 409 87 27.06 0.69 2.44 5.81 

PB09 -16+20 1.5 3.25 401 293 73.91 1.27 2.27 5.23 

PB10 -16+20 1.5 3.25 429 249 85.85 1.00 2.52 6.03 

PB13 -16+21 3 6.5 839 160 25.26 0.63 1.88 3.28 

PB16 -16+20 3 6.5 918 420 61.20 2.77 1.75 2.63 

PB07 -16+20 3 6.5 815 601 67.60 1.16 1.84 3.13 

PB08 -16+20 3 6.5 801 457 81.41 1.33 1.80 3.25 

PB04 -16+20 6 13 1692 375 34.12 2.35 1.38 1.62 

PB01 -16+20 6 13 1663 442 36.66 1.21 1.41 1.61 

PB02 -16+20 6 13 1575 508 67.98 1.73 1.43 1.63 

PB03 -16+20 6 13 1647 609 68.73 1.65 1.41 1.70 

PB06 -16+20 6 13 1607 549 83.80 1.65 1.40 3.06 

PB05 -16+20 6 13 1702 519 84.04 3.59 1.37 3.01 

PB15 -16+23 12 26 3408 178 28.00 1.07 1.05 0.90 

PB12 -16+20 12 26 3447 330 76.18 0.71 1.11 0.90 

PB17 -16+20 12 26 3028 194 35.00 2.01 1.14 0.90 

PB18 -16+20 12 26 3319 378 68.78 1.67 1.30 0.96 

PB11 -16+20 12 26 3459 450 83.47 1.83 1.12 0.95 
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PB01 

Bead Used -16+20 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 20 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 1.03 

Retroreflectivity 442 

Bead Count 1663.00 

Calculated 

%embedment 1116 

VTMR 1.20902 

Nearest Neighbor dist(mm) 1.410104 

XNN (mm) 8.80 

 

 

PB02 

Bead Used -16+20 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 20 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.98 

Retroreflectivity 508 

Bead Count 1575.00 

Calculated 

%embedment 67.98 

VTMR 1.73 

Nearest Neighbor dist(mm) 1.43 

XNN (mm) 1.63 
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PB03 

Bead Used -16+20 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 25 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.97 

Retroreflectivity 609 

Bead Count 1647.00 

Calculated 

%embedment 68.73 

VTMR 1.65 

Nearest Neighbor dist(mm) 1.41 

XNN (mm) 1.70 

 

PB04 

Bead Used -16+20 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 20 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 30.52 

Retroreflectivity 375 

Bead Count 1692.00 

Calculated 

%embedment 34.12 

VTMR 2.35 

Nearest Neighbor dist(mm) 1.38 

XNN (mm) 1.62 
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PB05 

Bead Used -16+20 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 30 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.90 

Retroreflectivity 519 

Bead Count 1702.00 

Calculated 

%embedment 84.04 

VTMR 3.59 

Nearest Neighbor dist(mm) 1.37 

XNN (mm) 3.01 

 

PB06 

Bead Used -16+20 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 30 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.90 

Retroreflectivity 549.3333 

Bead Count 1607.00 

Calculated 

%embedment 83.80 

VTMR 1.65 

Nearest Neighbor dist(mm) 1.40 

XNN (mm) 3.06 
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PB07 

Bead Used 
-

16+20 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 25 

Bead Mass(g) 6.50 

Measured - Central Area 

Exposed diameter (mm) 0.98 

Retroreflectivity 601 

Bead Count 815.00 

Calculated 

%embedment 67.60 

VTMR 1.16 

Nearest Neighbor dist(mm) 1.84 

XNN (mm) 3.13 

 

PB08 

Bead Used 
-

16+20 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 30 

Bead Mass(g) 6.50 

Measured - Central Area 

Exposed diameter (mm) 0.92 

Retroreflectivity 457 

Bead Count 801.00 

Calculated 

%embedment 81.41 

VTMR 1.33 

Nearest Neighbor dist(mm) 1.80 

XNN (mm) 3.25 
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PB09 

Bead Used 
-

16+20 

Application Rate(lb/gal) 1.5 

Drawdown blade opening (mil) 30 

Bead Mass(g) 3.25 

Measured - Central Area 

Exposed diameter (mm) 0.95 

Retroreflectivity 293 

Bead Count 401.00 

Calculated 

%embedment 73.91 

VTMR 1.27 

Nearest Neighbor dist(mm) 2.27 

XNN (mm) 5.23 

 

PB10 

Bead Used -16+20 

Application Rate(lb/gal) 1.5 

Drawdown blade opening (mil) 40 

Bead Mass(g) 3.25 

Measured - Central Area 

Exposed diameter (mm) 0.88 

Retroreflectivity 248.6667 

Bead Count 429.00 

Calculated 

%embedment 85.85 

VTMR 1.00 

Nearest Neighbor dist(mm) 2.52 

XNN (mm) 6.03 
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PB11 

Bead Used -16+20 

Application Rate(lb/gal) 12 

Drawdown blade opening (mil) 30 

Bead Mass(g) 26.00 

Measured - Central Area 

Exposed diameter (mm) 0.90 

Retroreflectivity 449.6667 

Bead Count 3459.00 

Calculated 

%embedment 83.47 

VTMR 1.83 

Nearest Neighbor dist(mm) 1.12 

XNN (mm) 0.95 

 

PB12 

Bead Used -16+20 

Application Rate(lb/gal) 12 

Drawdown blade opening (mil) 20 

Bead Mass(g) 26.00 

Measured - Central Area 

Exposed diameter (mm) 0.95 

Retroreflectivity 329.6667 

Bead Count 3447.00 

Calculated 

%embedment 76.18 

VTMR 0.71 

Nearest Neighbor dist(mm) 1.11 

XNN (mm) 0.90 
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PB013 

Bead Used -16+20 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 15 

Bead Mass(g) 6.50 

Measured - Central Area 

Exposed diameter (mm) 27.78 

Retroreflectivity 160.3333 

Bead Count 839.00 

Calculated 

%embedment 25.26 

VTMR 0.63 

Nearest Neighbor dist(mm) 1.88 

XNN (mm) 3.28 

 

 

PB14 

Bead Used -16+20 

Application Rate(lb/gal) 1.5 

Drawdown blade opening (mil) 15 

Bead Mass(g) 3.25 

Measured - Central Area 

Exposed diameter (mm) 32.36 

Retroreflectivity 87 

Bead Count 409.00 

Calculated 

%embedment 27.06 

VTMR 0.69 

Nearest Neighbor dist(mm) 2.44 

XNN (mm) 5.81 
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PB15 

Bead Used -16+20 

Application Rate(lb/gal) 12 

Drawdown blade opening (mil) 15 

Bead Mass(g) 26.00 

Measured - Central Area 

Exposed diameter (mm) 30.43 

Retroreflectivity 177.6667 

Bead Count 3408.00 

Calculated 

%embedment 28.00 

VTMR 1.07 

Nearest Neighbor dist(mm) 1.05 

XNN (mm) 0.90 

 

PB16 

Bead Used -16+20 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 20 

Bead Mass(g) 6.50 

Measured - Central Area 

Exposed diameter (mm) 1.17 

Retroreflectivity 420 

Bead Count 918.00 

Calculated 

%embedment 61.20 

VTMR 2.77 

Nearest Neighbor dist(mm) 1.75 

XNN (mm) 2.63 

 

 

 

 

 

 



97 

  

PB17 

Bead Used -16+20 

Application Rate(lb/gal) 12 

Drawdown blade opening (mil) 15 

Bead Mass(g) 26.00 

Measured - Central Area 

Exposed diameter (mm) 26.49 

Retroreflectivity 194.3333 

Bead Count 3028.00 

Calculated 

%embedment 29.88 

VTMR 2.01 

Nearest Neighbor dist(mm) 1.14 

XNN (mm) 0.90 

 

PB18 

Bead Used -16+20 

Application Rate(lb/gal) 12 

Drawdown blade opening (mil) 15 

Bead Mass(g) 26.00 

Measured - Central Area 

Exposed diameter (mm) 0.97 

Retroreflectivity 378 

Bead Count 3319.00 

Calculated 

%embedment 68.78 

VTMR 1.67 

Nearest Neighbor dist(mm) 1.30 

XNN (mm) 0.96 
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PS01 

Bead Used -30+40 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 5 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.37 

Retroreflectivity 212.6667 

Bead Count 33418.00 

Calculated 

%embedment 86.48 

VTMR 23.39 

Nearest Neighbor dist(mm) 0.32 

XNN (mm) 0.17 

 

PS02 

Bead Used -30+40 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 5 

Bead Mass(g) 6.50 

Measured - Central Area 

Exposed diameter (mm) 0.39 

Retroreflectivity 343.3333 

Bead Count 15752.00 

Calculated 

%embedment __z 

VTMR __ 

Nearest Neighbor dist(mm) 0.43 

XNN (mm) 0.37 

 

 

 

 

 

 



99 

  

PS03 

Bead Used -30+40 

Application Rate(lb/gal) 1.5 

Drawdown blade opening (mil) 5 

Bead Mass(g) 3.25 

Measured - Central Area 

Exposed diameter (mm) 0.40 

Retroreflectivity 329.3333 

Bead Count 8381.00 

Calculated 

%embedment 67.61 

VTMR __ 

Nearest Neighbor dist(mm) 0.57 

XNN (mm) 0.57 

 

 

PS04 

Bead Used -30+40 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 10 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.34 

Retroreflectivity 360.6667 

Bead Count 29449.00 

Calculated 

%embedment 83.60 

VTMR __ 

Nearest Neighbor dist(mm) 0.39 

XNN (mm) 0.23 
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PS05 

Bead Used 
-

30+40 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 5 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) 0.32 

Retroreflectivity 453 

Bead Count 0.00 

Calculated 

%embedment 88.05 

VTMR __ 

Nearest Neighbor dist(mm) 0.50 

XNN (mm) 0.48 

 

PS06 

Bead Used -30+40 

Application Rate(lb/gal) 1.5 

Drawdown blade opening (mil) 5 

Bead Mass(g) 3.25 

Measured - Central Area 

Exposed diameter (mm) 0.33 

Retroreflectivity 448.3333 

Bead Count 9227.00 

Calculated 

%embedment 86.95 

VTMR 89.37 

Nearest Neighbor dist(mm) 0.47 

XNN (mm) 0.51 
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PS07 

Bead Used -30+40 

Application Rate(lb/gal) 6 

Drawdown blade opening (mil) 1 

Bead Mass(g) 13.00 

Measured - Central Area 

Exposed diameter (mm) __ 

Retroreflectivity 154.3333 

Bead Count 31196.00 

Calculated 

%embedment 3.93 

VTMR 4.65 

Nearest Neighbor dist(mm) 0.33 

XNN (mm) 0.18 

 

PS08 

Bead Used -30+40 

Application Rate(lb/gal) 3 

Drawdown blade opening (mil) 1 

Bead Mass(g) 6.50 

Measured - Central Area 

Exposed diameter (mm) __ 

Retroreflectivity 98 

Bead Count 17635.00 

Calculated 

%embedment 15.89 

VTMR 4.87 

Nearest Neighbor dist(mm) 0.41 

XNN (mm) .35 
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PS09 

Bead Used -30+40 

Application Rate(lb/gal) 1.5 

Drawdown blade opening (mil) 1 

Bead Mass(g) 3.25 

Measured - Central Area 

Exposed diameter (mm) __ 

Retroreflectivity 0 

Bead Count 9277.00 

Calculated 

%embedment 11.54 

VTMR __ 

Nearest Neighbor dist(mm) 0.55 

XNN (mm) .66 

 


